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0.2. Background

In late 2010 the director of DLF, now again part of CLIR, got approval from CLIR and the DLF 

advisory committee to recreate and refresh the DLF web presence. Soon after moving back to 

CLIR, DLF had also put its independent website on ice in deference to a presence on the CLIR 
website. But the director soon heard that DLF membership wanted more of an opportunity to 

network and share information, they wanted a DLF site again.

In 2008/2009 the DLF staff had worked with Eric Celeste and eCoreXperience to develop a new 

website. With Eric they developed a new program for this site, and with eCore they designed and 

built the site out as a Drupal site. That redesigned DLF website was never rolled out, because DLF 

moved back to CLIR just as it was near completion in early 2010. 

The director and the advisory committee decided to move ahead with a plan to keep that new 

design, but roll it out as a WordPress site instead of a Drupal site. This document describes the 

WordPress site that resulted from this plan. It is a guide to the site and its maintenance, intended 

for CLIR staff charged with keeping the site up-to-date.
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1. Site Structure

We see so many websites that we tend to think we know what they all look like. Let’s start with an 

agreement on what to call various parts of the Digital Library Federation website. These may not be 
the best names possible, but if we at least agree to use these names when we talk about this site, 

then we can at least avoid misunderstanding. The next few pages are simply illustrations of a few 

different types of pages you will find on the DLF site. Scrawled across these images are the names 

I will use for parts of the site in the remainder of this introduction to WordPress and the DLF site.

WordPress sites consist of two basic types of content: pages and posts. Pages are relatively static 

content that often describe the organization or certain events, like a DLF Forum. Posts are the 

stories that flow through the site over time, the news of the organization. In the case of the DLF 

site, we have also created a special home page which combines elements of both pages and 

posts. The home page is, in fact, a “page” in the WordPress sense of that word, but it uses a 

special design that includes some posts surrounding the page content and a special form of the 
sidebar.

The look of the site is controlled by the “theme” WordPress has been told to use for this site. That 

theme consists of a set of PHP code, HTML, CSS, and graphics files that define the design. In our 

case the theme is one developed specifically for the DLF called “diglib”. More information about the 

theme can be found in appendix 4.2. For now, just know that almost everything about the look of 

the site, from the graphics around the borders, to the fonts, to the colors of text, all of that is 

managed by the theme and not in your direct control. All you have to worry about is the content of 

the site, which can be complex enough a task. If you ever find yourself working hard to try to make 

a page or post look a particular way, step back and consider whether you should maybe get in 

touch with whoever is maintaining your theme and ask for a new feature to do what you need.
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1.1. Parts

main menu
meta menu

submenu
page title

footer

sidebar

content

section title

sidebar 
note

sidebar 
box

admin bar

Figure 1.1.A. Typical page and its parts
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Figure 1.1.B. The news page and its parts

Figure 1.1.C. A single story and its parts
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Figure 1.1.D. The home page and its parts
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1.2. Navigation

You can get around the DLF site by using any of three menus or the sidebar. Of course, links can 

be found anywhere on the page, but these three areas are devoted to navigation. The DLF logo at 

the upper left side of every page serves a link back to the home page of the site. It also visually 
marks the top of the sidebar and indicates its width. Just below the DLF logo on every page 

(except the home page itself) is a small “section title” area that also serves as a link back to the top 

page of that current section. Clicking the section title has the same effect as clicking on that 

section’s item in the main menu.

1.2.1. The Main Menu

The main menu which sits just above the white area of the page (see figure 1.1.A. for an example) 
is the most obvious navigation element of the site. The entries on this menu are always only one 

word and take you to the top page of their respective sections. The DigLib theme finds items to 

place in this menu by looking at all the pages at the top level of WordPress’ page hierarchy (pages 

without any “parents”); any of those pages which include a custom field called “IncludeInMenu” 

with a value of “yes” will get included in the main menu. If the page also has a custom field called 

“ShortName” then the value of that field will be used in the menu instead of the actual title of the 

page. 

This menu should only be used to identify major sections of the site. Note that it is quite finite in 

width, so items need to be brief. It should not be allowed to grow to any longer than one line. 

1.2.2. The Submenu

The submenu sits at the top right of the white area of the page (see figure 1.1.A. for an example) 

and shows the “second level” pages for the current section. WordPress defines a hierarchy for its 

pages. While editing a particular page you can choose a “parent” for that page. If a page has a 

parent, then it lies under that page in the WP page hierarchy.  Whenever a user lands on a page, 

the DigLib theme tries to find out what section of the site that page belongs to by traversing this 

WP page hierarchy, looking for the “section top page” sitting at the top level of the hierarchy. Once 
it finds that “section top page” the theme then looks one level down (to the second level, in other 

words) for pages that include a custom field called “IncludeInMenu” with a value of “yes”. These 

are then displayed as the submenu.

These submenu items can highlight content within a section that might not otherwise be obvious to 

a visitor. For example, the “About” section includes a staff listing, and the “Staff” submenu takes 

you there. There may be many pages in a section that don’t actually get a mention in the submenu, 
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which is fine. The “Forums” section, for example, would be a bit overwhelming if every second level 

page were on the submenu. Be judicious in your inclusion of pages on the submenu.

1.2.3. The Meta Menu

The menu at the very top of the page is called the meta menu (see figure 1.1.A. for an example) 

and contains items that you have no control over. These are all built into the DigLib theme, so they 

can be changed by fiddling with theme files, but for the most part you should consider them 

frozen. These items are in some way descriptive of the site itself. They include a link back to the 

main CLIR website, a site map for anyone curious enough to see everything (mostly web crawlers 
benefit from this), and the “contact us” item which lets people know who to correspond with if they 

have concerns about the site. 

The meta menu also includes a “login” item that most users will never need or try. However, for 

you, the maintainer of the site, the login item is crucial since it lets you identify yourself to the site 

and gain access to the WP back end where you can manage site content. If you are logged in, you 

will see your user name in a welcome message just below the meta menu. This serves as a 

reminder that you are, indeed, logged in. The login item on the meta menu turns into a logout item 

whenever you are already logged in.

1.2.4. The Sidebar

The sidebar of the DLF site is presented to the left of the main page content, below the DLF logo 

itself. The sidebar serves a dual purpose: it can contain links that facilitate navigation around the 

site, but it also can contain site content that helps orient users to the site as a whole or to the 

particular page they are looking at. There are a number of ways to get content into the sidebar, 

none of them terribly obvious! The typical sidebar can be seen in figures 1.1.A., 1.1.B., and 1.1.C. 

The home page has a very special version of the sidebar which is visible in figure 1.1.D.

1.2.4.1. Sidebar Notes

Sidebar notes can explain something about the whole site, about a section of pages, or about a 

single page. Putting text into the sidebar calls attention to that text in a special way, alerting the 

visitor to important information. Sidebar notes display a grey bar to the left of the text in the 

sidebar. There are three sources for sidebar notes: a “Global Sidebar Note” page, the 

SidebarNotes custom field on the section top page, and the SidebarNotes custom field on the 

current page itself.

A special page exists on the site called “Global Sidebar Note” and whatever content is found on 

that page becomes the first part of the sidebar note on every single page. This universal note can 

be used to convey information that is important for every single visitor, no matter the page they 

visit. It could be a note about the state of the site (for instance, before deployment we had a global 
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sidebar note that stated the site was not yet official and contained a link to the CLIR page for the 

DLF program) or some kind of “advertisement” (like a note about an upcoming form with a link to 
details or registration).

Each page can also contain a custom field called “SidebarNote” whose value will be used as the 

HTML text for a sidebar note. If the page is a section top page, then all the pages below it in the 

WP page hierarchy will display this note.

If multiple sidebar notes are found, they are displayed in order from most global to most specific.

1.2.4.2. Sidebar Boxes

There are three kinds of sidebar box, but all of them share one significant attribute. All sidebar 

boxes are intended to aid in site navigation, and so they should all be, at heart, a collection of links 

to other locations on the site. Each box should start with a headline and be followed by a list of 

links. Each box is set apart as a beige box in the sidebar.

1.2.4.2.1. The SidebarBox

The most flexible type of sidebar box is defined by including the “SidebarBox” custom field on a 

page. The value of the SidebarBox field is the identifier of another page on the site and the 

contents of that page will be used as the contents of the box. This means that anything at all could 

be included in the box, but best practice limits you to just including a single headline and a list of 

links.

The Forum pages use this feature extensively. Each forum is represented by a set of pages that 

include schedules, resources, conference details, and so on. In order to make it easy to go back 

and forth between pages related to a single forum, it helps to create a page with a headline naming 

the forum and a list of all the pages relating to that forum. This identifier of this page can then be 
used as the value of the SidebarBox field for each of the pages related to the forum. This way 

changes to the list can be made to the page defining the box, and will automatically be visible on 

all the related pages.

1.2.4.2.2. The RelatedLink

Sometimes you don’t really need all the flexibility of the SidebarBox, but just want to include a list 

of related links on your page. As long as these links are only to other pages on the site, you can 

use the “RelatedLink” custom field to refer to these. Just include the page identifiers for each 

related link (separated by commas) in the RelatedLink field. The DigLib theme will create a box with 

the headline “Related Links” that shows a list of these page titles.
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The DigLib theme will also include any RelatedLink value found on the section top page on any 

pages within that section. In other words, any RelatedLink you put on the section top page will be 
displayed on all the pages of that section.

1.2.4.2.3. The Blog Box

You don’t have any direct control of the blog boxes. These are created by the DigLib theme 

automatically and included on pages of the News section (see figure 1.1.B. and 1.1.C.). They 

include things like recent stories and the archives of past stories.

1.2.4.3. The Admin Bar

This grey bar stays at the top of the page to help any user with certain administrative or editing 

privileges remember that they are logged in to the site and find their way to important backend 

facilities of WordPress. If you are not logged in with sufficient privileges, you will not see the admin 

bar at all.

If you are allowed to edit the current page, the admin bar will provide a link that goes directly to the 

page editing interface of WordPress. There are also links to the dashboard and to links for creating 

new pages or posts. The number next to the edit page or post link is the ID number of that page or 

post. 

1.2.4.4. Home Sidebar Widgets

The sidebar of the home page is a special case. It does not use any of the notes or widgets 

mentioned above. Instead, the home sidebar uses widgets built into WordPress or added to it by 

plugins. You can add and remove widgets to the home sidebar or change their settings by using 

the Appearance > Widgets option in the WordPress backend. Just make sure you are changing 

the “Home Sidebar” if you want to see those changes on the home page.

1.2.6. Search

Visitors can also get around the site by searching for content. Since the native WordPress search 

engine can only retrieve content from the WP database, search on the DLF site has been 

implemented via a Google Custom Search Engine (more details of which are in the appendix). The 

Google CSE search covers not only site content, but it also searches various uploaded document 

formats (such as PDF and DOC) and all the content in the old DLF site. Typing a query in the 
search box at the top of the page and hitting return (or clicking the yellow triangle) will execute a 

search. The results look pretty much like Google and should be easy enough for most users to 

navigate. 
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1.2.6. The Footer

The footer sits at the bottom right of every page. It is similar to the meta menu in that it contains 

information about the site, or about the specific page being displayed. The footer content is all 

defined by the DigLib theme and can only be changed by changing theme files. The CLIR logo and 

reference to CLIR link back to the CLIR website. The theme presents as much information as it can 

about when a page was last edited and by whom. The “some rights reserved” statement currently 

links to the Creative Commons license for site contents (a version 3.0 by-nc license). The privacy 

statement links to an otherwise well hidden “Privacy” page in the “About” section of the site. 

The presence of the footer also provides a pretty good indication that all of the PHP scripts 

required for the theme to present the page ran properly. Usually, a show-stopper issue in the PHP 

will also prevent the presentation of the footer.
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1.3. Content Flow

Much of the content on the site is static and does not “flow” anywhere. This is pretty much true of 

all the “pages” on the site. Even in these cases, though, the titles of pages sometimes do flow to 

other parts of the site. For example, the titles of some pages (or the ShortName field, if it is filled in)
become the items on the main menu and submenu. The titles of pages also become the link text in 

RelatedLink boxes in the sidebar.

The news stories flow around a lot more. A news story is created by writing a new “post” in 

WordPress. This is essentially an new story in the “blog” portion of the site, which lives in the 

“News” section of the site. When we talk about the DLF site news more or less equals stories 

which more or less equals blog. A new story always lands on the main News page, which bears 

the collection title “Recent Stories”. It also becomes part of the news archives, going into a 

collection for the month and year it was written. If the story is properly categorized, it also goes into 

the collection pages for each category. The most recent five stories will also appear as headlines 

with partial text on the home page. The most recent news story given the category “Feature” will 
also be displayed in full on the home page. Whenever the Section Title is “News” you know that 

you are looking at a page that is really a part of the WordPress “blog” made up of our stories.

Editing a story by editing its WordPress post will change the story wherever it happens to appear. 

In reality, all these pages and posts are really just entries in a database that WordPress consults 

one story

shows up in
many places
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when it presents any given page. This content is not being duplicated when it appears in more than 

one “place”, rather it is just being shown as part of rendering each of those pages.

News stories will also become part of the DLF site’s RSS news feed. None of the static page 

content becomes part of that feed.

Parts of the sidebar are also drawn from special segments of the site. The page “Global Sidebar 

Note” becomes the first sidebar note on every page of the site. Just empty out the content of this 

page to remove the global note. The custom SidebarNote field likewise becomes a note on its 

page, and if the page is a section top page, then on every page of that section. Any page can 

contain content that becomes a sidebar box by being referred to in a custom SidebarBox field of 

another page. When in the News section, various stories become part of the boxes in the sidebar.

Some content flows into the DLF site from the outside world. The home sidebar contains a widget 

(feedgator) that brings some RSS feed content from DLF community sites onto that sidebar. 
Another widget (Twitter Widget Pro) brings @clirdlf tweets onto the home sidebar. The sidebar of 

the Community section top page is also full of content from RSS feeds around the DLF community 

facilitated by another plugin (RSS Shortcode). 
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2. Maintenance

Many of the pages can stay fairly static. Much of the dynamism and currency of the DLF site will 

come from creating a steady flow of stories for the News section and categorizing them well. But 
certain pages deserve special attention.

The home page content should be updated regularly. This content does not have to be very long, 

in fact the page will look best if the content stays brief, but it should be current, up-to-date, forward 

looking content. Make sure it is always about the next great thing DLF will be doing, a pointer to an 

event, a meeting, or the next Forum. Use feature stories to talk about new publications or 

happenings around the community, use the content of the home page to highlight the next great 

DLF do.

The Forum pages should also be carefully maintained. The information about upcoming forums 

should always be clear and accessible, with a nice sidebar box for each year to knit each forum’s 

evolving set of pages together. Both the sidebar box page and the forum page will deserve regular 
attention.
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2.1. Creating Stories

Most of the time when editing this site you will be creating stories. In WordPress terms you will be 

creating posts. Since most stories are brief and self-contained, you will usually create and edit 

them, then never come back to them. However, if you discover errors or need to add an update to 
a story, you can always return and edit it again later.

There is really nothing special about creating and editing posts on this site, you can use any 

WordPress book to get oriented to the task. Here are just a few of the basics.

To create a story, choose “Add New” from the “Posts” section of the left 

sidebar in the WordPress backend or choose “Post” from the “Add New 

menu on the Admin Bar. You will only be able to see this item if you have 

logged in to the site and have the authority to edit posts.

• Enter the title and content you would like for the story in the appropriate 

fields. 

• Make sure that if you paste text from another source you are either pasting into the content in 
HTML mode or, if you are using Visual mode, you paste using the “Paste as Plain Text” tool 

(that’s the icon of a pasteboard with a “T” on it in the second row of toolbar icons). 

• In general, I recommend editing in HTML mode if you are familiar with HTML. This will give you 

much more precise control of your text. However, the visual mode works well and can be a lot 

easier to deal with. Just be sure to always follow the pasting instruction above in visual mode, or 

you may end up with pages that have awkwardly sized or formatted text. Also, be sure to take 

advantage of tools like the “Unordered List” tool to create proper bulleted lists, what gets pasted 

in will usually not take advantage of our list styles unless you do this.

• Whichever way you edit, remember to keep it simple. Stories are fed into many contexts that you 

don’t control, so aggressive formatting will backfire. In general you should avoid going beyond 
bold, italic, and bulleted lists.

• Choose a category for your story, or more than one. 

• Categories are an essential part of the “flow” of stories around the site. The category “Feature” 

will get the story featured on the home page, the category “Jobs” will get the story listed on the 

“Employment Opportunities” page, and so on. It is worth taking a moment to get this right.

• Feel free to add tags for your story, though this is not required.

• Feel free to backdate your story using the clicking on “Edit” next to the little calendar in the 

“Publish” box at the top of the right sidebar.

• Publish! Don’t forget to click the “Publish” or “Update” button to save your changes!
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2.2. Editing Pages

Once you log in to the site with an account that allows authoring pages, each page of the site will 

display an “edit” link on the Admin Bar. Clicking that link will take you to the WordPress backend 

and the editing interface for that particular page. You can also go to the backend and find the page 
on the list of pages, clicking on its title there will take you to the same 

editing interface.

You can pick up a book about WordPress to learn more about editing 

pages, so here we will just concentrate on a few things that are unique to working with the diglib 

theme in use on this site. The basics of creating and editing pages are just like creating and editing 

stories, so refer to the previous section for hints. Pages don’t have categories and tags, but just 

like with stories, don’t forget to click “Publish” or “Update” if you want your changes saved!

If this is a new page, pay attention to a few initial setup items:

• Make sure the commenting features are turned off (unless you really want them on, which would 

be unusual for a page). 

• After you publish it for the first time, take a look at the “Permalink” and make sure it is brief, 

preferably one word. You can only edit the last bit highlighted in yellow. Do so if there is a better 

unique term to use in the URL for the page.

• Make sure you have assigned the page an appropriate parent in the WordPress page hierarchy. 

You can do this using the popup menu in the right sidebar.

• If your page will be visible in the navigation menus, make sure you give it an order number (just 

below the parent pop-up) that will place it in the correct relationship with its siblings on the menu.

Note that when you edit the content of a page, the old version of that content is stored in a revision 

history. You can access and recover those revisions at the bottom of the edit screen for a page. 

However, none of your changes to custom fields or other metadata such as parents or order will be 
saved in that revision history. Tread lightly in those areas, you are without a net!

If you want the page to appear on menus, include sidebar text, or take advantage of other special 

features of our diglib theme, you will also have to give it some custom metadata. If you are editing 

a page and you don’t see the “Custom Fields” box below the editing box, then check your “Screen 

Options” tab (upper right) and make sure the checkbox next to “Custom Fields” is selected. In the 

“Custom Fields” you can use the “Select” popup menu to pick a custom field, then enter an 

appropriate value, and then click “Add Custom Field” to attach it to the page.

Since these custom fields are unique to the diglib theme, let’s take a moment to document them.
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Custom field: IncludeInMenu

This field is used to make a page visible to the menus built into the diglib theme. If a page has no 

parent then it setting this field to “yes” makes it visible on the main menu. If a page has a parent 

without a parent, then setting this field to “yes” makes it visible on the submenu for its parent’s 

section of the site. Make sure you type only “yes” in lowercase letters into the value to make a 

page visible, anything else will leave the page off the menus.

Custom field: RelatedLinks

If this field is present, then the value will be used to generate a “Related Links” box for the sidebar 

of this page and all its children. The value should be a set of number separated by commas 

without any spaces. Each number will be interpreted as the ID number of a page or post. Those ID 

numbers can be found next to the “Edit” link in the Admin Bar of the page in question. The 

“Related Links” box will display the titles or ShortNames of the pages in the sidebar.

Custom field: ShortName

Sometimes the title of a page would be awkward for a menu entry, particularly if it is too long. This 

field can be used to supply an alternate and shorter name for a page that the diglib theme will use 

whenever it refers to the page in navigation elements like menus.

Custom field: SidebarBox

If you want a particular set of links and text in a sidebar box you can create a page with the 

content that you want to use. That page will have an ID number, just like any other page. If you 

then put that ID number into the SidebarBox of another page, that page, and all its children, will 

display the special sidebar box. For example, let’s say that we’ve created a sidebar box with a 

bunch of links relevant to the DLF Forum 2030 and called that page “DLF 2030 Sidebar”. Once 

published it gets the ID number 437. On our “DLF Forum 2030” page we will create a custom 

SidbarBox field with the value 437. Presto, our forum page and all its children will display the box 

with all the relevant links defined in the “DLF 2030 Sidebar” page.

Custom field: SidebarNote

Sometimes you just want to convey a brief note to the user in the sidebar. If the SidebarNote field 

is present then its value will be interpreted as HTML for a sidebar note. This note will be displayed 

on this page and all its children. Remember, since this is being interpreted as HTML you will have 

to include tags for paragraphs and links. For example, your note’s value might be “<p>Please refer 

to the <a href=‘http://www.clir.org’>CLIR website</a> for more information on this matter.”
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2.3. Editing Outside WordPress

In addition to using the WordPress backend to create stories and edit pages, you can use any 

number of WordPress-compatible desktop and mobile applications. Each of these has a unique 

set of features and requires its own configuration dance to get rolling, here we will look at setting 
up MarsEdit as just one example.

MarsEdit from Read Sweater (http://www.red-sweater.com/marsedit/) is a blog editor for the 

Macintosh. When you start MarsEdit for the first time it won’t know anything about the DLF 

website. To set up our site, just choose “New Blog” from the “File” menu and type the name and 

URL of our site into the dialog box that appears. MarsEdit will then try to connect to the blog and 

ask you for your name and password. Use the same name and password you use to log into the 

WordPress backend.

MarsEdit will then download a copy of all the pages and the most recent stories from the site. 

MarsEdit keeps its own copy of these locally on your computer. Whenever you need to be sure you 

have an up-to-date local copy you should choose “Refresh All” from the “Blog” menu to force 
MarsEdit to repeat this download. This is especially important if you are not the only person editing 

the site.

To edit a page or existing story, just double-click it from the list MarsEdit displays. To create a new 

story choose “New Post” from the “File” menu, for a new page choose “New Page”. MarsEdit will 

present a new window in which you can edit your post. You can choose to “Edit Rich Text” or “Edit 

HTML Text” from the “Post” menu. Rich text is similar to WordPress’ “visual” mode and just as you 

must be careful pasting into WordPress when using visual mode editing, you should make sure to 

only paste into MarsEdit with the special “Paste and Match Style” in the “Edit” menu if you are 

using rich text editing.

MarsEdit will let you add categories and tags, but it does not (without further configuration) let you 
edit the custom fields that drive our theme. To change those, just go back to the WordPress 

backend.

Finally, to publish your changes back to the site from MarsEdit use “Send to Blog” from the “Post” 

menu. You can “Save” your changes using the “File” menu, but that only saves a local version to 

your computer. Use “Send to Blog” to change the site.

MarsEdit has a few hidden features that can also help smooth the task of maintaining the site. For 

example, I recommend you adjust the columns that it shows for the list of posts and pages. Go to 

the “View” menu, choose “Columns”, and then add “Post ID” and “Tags” and remove “Weblog”. 
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Note that you can also rearrange the items in the column view by dragging them by their headers 

until they are arranged in a way that works for you. Those post IDs are the same numbers you 
need to refer to when using the RelatedLinks or SidebarBox custom fields.

MarsEdit also lets you adjust the number of pages it retrieves from the server. We have a lot of 

pages on the site, so you will probably want to download more than the standard latest 20 pages. 

To adjust this, choose “Edit Settings...” from the “Blog” menu. In the “General” tab you will see two 

numbers for how many recent pages and posts are to be downloaded. I would recommend raising 

the pages number to 100 so that you will get all the pages we create. You can probably leave the 

posts number down at 20 or 30 since those stories tend to be more timely and you are only likely 

to edit the most recently created ones. Remember, regardless of what MarsEdit downloads, you 

can edit anything from the WordPress backend itself.

Finally, while you have a page open for editing in MarsEdit, check the “View” menu again. Toward 
the middle are a few extra fields you can choose to display. For example, you might want to see 

the “Slug” assigned to the page (which becomes part of the URL for that page). These choices 

become the default for every time you edit pages or posts.

The “Add Custom Fields...” in the “View” menu deserves some special attention. With this you can 

display our custom fields as described in section 2.2. Just choose this option, click the little plus 

sign (+) in the window that follows, and type a label name and a field name for the custom field. I 

would suggest making both the label name and the field name the name you find for that feature in 

section 2.2.

MarsEdit and other desktop blog editors are full of features that have not been explored in this brief 

guide. Explore all the nooks and crannies and have fun editing your site!

Intro to WP for the DLF / 2 March 2011 / Editing Outside WordPress! 20



2.4. Updates

WordPress updates are usually quite straightforward and easy to carry out. One complication is 

that we also use a number of plugins which may require updates of their own, with or without 

updates to WordPress as a whole. If you are not authorized to update WordPress, then all you may 
see are notes on the dashboard letting you know an update is available and to talk about this with 

your system administrator. If you have been designated an administrator of this WordPress 

instance, then the rest of this section is for you!

 If you are an administrator and an upgrade is available, 

then a notice will appear in a yellow bar across the top 

of your dashboard. It will include a link to more 

information about the latest WordPress version and a link to “Please update now.” WordPress 

updates have been very stable for a few years now, so I think it is advisable to go ahead and 

update when an update is made available. But you can read the information about a particular 

version and unless security updates are being made, you should also feel free to skip or delay 
updates, you will just have to tolerate the reminder bar until you get current again.

We have a process in place to backup the whole site and database every night. In addition, we 

have VaultPress running for an up-to-the minute backup. This means that you can trust the 

automatic update to do the right thing, because if it fails we should be able to recover the site. Still, 

after running the automatic update it is important to check out the site, both public side and the 

backend dashboard, to make sure everything appears to be working. If you notice anything 

unusual, please contact your WordPress support person right away. As we launch the site, this is 

Eric Celeste (efc@clst.org), but that support person may change over time, so know who it is.

If you are an administrator you will also be responsible for updating plugins used by the site. To see 

which plugins need updating, just go to the plugins screen of the dashboard. Each plugin with an 
update available will have its own yellow bar in the list. Note that some plugins are deactivated and 

only used from time to time to manage the site. These plugins in the list below are necessary for 

the day to day operation of the site. Those highlighted are required for the site to even render 

properly, so it is especially important that they be kept in place.
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Plugin Name What it does for us

Admin Bar ID Menu adds ID number to edit links in the Admin Bar

Akismet prevents spam comments from littering the site

Broken Link Checker does what it says, puts notices on the dashboard

Email Post Changes send email about page and post changes to those interested

feedgator test provides the Community Notes found on homepage sidebar

Google Analyticator adds Google Analytics code to each of our pages

HTML Page Sitemap provides the page list used for the site map

Janrain Engage allows users to log in using existing identities like Facebook

List category posts supplies the “catlist” shortcode used to put stories on pages

List Pages Shortcode supplies the “child-pages” and “list-pages” shortcodes

List pages span used by our theme to build the navigation menus

RSS Shortcode used to show the news feeds in the community sidebar

TimesToCome Stop Bot 

Registration

makes deleting spam user accounts easier by providing the 

“Comment Count” tool in the Users section of the dashboard

Twitter Widget Pro provides the twitter feed found in the homepage sidebar

VaultPress provides a consistent backup of our site

WP Super Cache can be used to improve site performance if it starts feeling 

slow
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3. Managing the Domain

WordPress is installed on a server at DreamHost that also runs the diglib.org domain in general. 

While the WordPress site will often feel like the diglib.org domain, they are not one and the same. 
For example, the domain also includes the old.diglib.org site with older DLF content and 

DreamHost also manages the email addresses @diglib.org separately from WordPress. Knowing 

something about how the domain is managed is important to maintaining the DLF site.
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3.1. Hosting

The diglib.org domain was registered with Network Solutions. It is important to realize that for the 

DLF site to work properly the Network Solutions account must point to DreamHost name servers. 

The website itself is hosted at DreamHost. DreamHost provides this account to CLIR for free, since 

CLIR is a non-profit organization. This same DreamHost account could also be used to run a 

clir.org account in the future, since multiple domains can be managed from a single account. For 

now, we are only hosting the DLF site at DreamHost.
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3.2. Domain Name Service (DNS)

Our domain name service (DNS) is being provided by DreamHost. Basically, Network Solutions 

points to DreamHost and DreamHost points to our servers, which happen also to be at 

DreamHost.

DNS is a tricky beast and it would be best to not touch this at all unless you really know what you 
are doing. The fact that both DNS and our servers are handled by DreamHost means that much of 

the configuration can be handled automatically by DreamHost. This is a good thing!

If you really do need to fiddle with the diglib.org DNS settings, just click on “Manage Domains” in 

the DreamHost “Toolbox” once you get to the DH control panel.
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3.3. Old DLF Site

Before we launched the WordPress site, the DLF site was run in an altogether different way at an 

altogether different host. That old site was managed by editing individual files with DreamWeaver 

and uploading them to the earlier host. All of those files have been transferred to DreamHost and 
now live in the old.diglib.org domain. To make things simpler for people who may have bookmarks 

or links to this old content, any attempt to reach a page at www.diglib.org that fails will 

automatically attempt to find the same page at old.diglib.org before putting up a “file not found” 

error message. The old pages have been modified, though, so that they warn users that the site is 

no longer being maintained and that they should refer to the new site instead.

As the note says, we are no longer maintaining content on the old site. Don’t bother editing any of 

the pages there.

Intro to WP for the DLF / 2 March 2011 / Old DLF Site! 26



3.4. DLF E-Mail Addresses

The mailing lists for DLF are under CLIR management and not covered here. However, DreamHost 

can forward mail from the diglib.org domain to other addresses. We use this to manage the 

info@diglib.org email address, for example.

To add or edit these addresses, just choose the “Manage Email” option in the DreamHost 

“Toolbox” after you get to the DH control panel.
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3.5. Getting to the files

The WordPress site is just a set of files in our space on DreamHost. Unlike the old DreamWeaver-

based site, you will hardly ever have to manipulate these files directly, but it is important to know 

how to get to them just in case you ever need direct access. For example, if a WordPress update 
goes awry you may need to install a fresh copy of WordPress manually, if a plugin you try actually 

crashes WordPress you may need to remove it manually.

It is best to use SSH or SFTP to access files at DreamHost. These tools avoid passing password 

around the internet “in the clear” affording better security than tools like plain FTP. The credentials 

for accessing this account are in Appendix 4.4.3.

Here are some of the directories you will find when you reach this files space:

Directory Contents

wp.diglib.org our WordPress site files, this is the WP installation that matters!

old.diglib.org the old files from the pre-WordPress DLF site, still served up when 

needed, the errorpage.php file here is the file-not-found page 
even for the current WordPress site

new.diglib.org the aborted Drupal site developed in 2008/2009, no longer 

needed, but still served from http://new.diglib.org (which should 
probably be turned off)

bin the home for a few scripts that do things like backup or batch 

modify the files we are using

backups backups of our databases and live installations are in here

diglib.dreamhosters.com a site served up by a URL of the same name that hosts obscure 

administrative info, including a downloadable backup of the whole 
DLF site and database

Maildir & logs directories maintained by DreamHost that should be left alone

efc a place Eric has stuffed files he is working with, also should be left 

alone
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3.6. Backup and Restore

WordPress itself takes care of the most common backup and restoration need, recovering from the 

mistaken edit of a particular page or post. Each edit page 

on WordPress includes a “Revisions” section (if you don’t 
see it, check the “Screen Options” near the top right of the 

window). You can use this to recall previous versions of the 

page going back at least a few weeks, comparing them to 

each other, and restoring any one of them to the current 

content of the page.

We have also purchased a VaultPress account for the DLF 

WordPress site. VaultPress is a very new service from the 

creators of WordPress, in fact, it is still in beta testing and 

we are one of the early adopters. VaultPress keeps a copy 

of everything from the DLF WordPress site offsite at the VaultPress servers. These backups are 
made minute to minute as changes are made on 

the site. These backups also include things like 

the WordPress themes and plugins we use on 

the site. The VaultPress team is still working on 

the automated restoration tools they intend to 

build into the system, but for now we can 

recover the VaultPress files from “https://

dashboard.vaultpress.com” and restore them 

manually. Until their automated recovery tools are in place, this sort of restoration will take some 

WordPress and Unix expertise, but these backups will be by far the most current we can get.

Of course, there are parts of the web site that are not page or post content. The theme files, files 

that have been uploaded alongside posts, the files that belong to the old website, all these live 

outside the WordPress database. All of these files are also backed up by DreamHost on a regular 

basis, and you can restore these DreamHost backups as well, if you need to. DreamHost can 

restore either a database or a filesystem, but not individual posts or files. This means that you can 

roll back the whole state of your site to what it was hours or days ago, depending on what 

backups DreamHost happens to have available. To restore the WordPress 

database, go to the “MySQL Databases” item on the DreamHost control 

panel sidebar and then look for the “wp_diglib_org” database. Next to it you 
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will see a “Restore DB” button. To restore the filesystem being used by 

WordPress at DreamHost, choose “Manage Domains” from that same control 
panel sidebar, look for the “wp.diglib.org” domain, and use the “Restore” button 

there. The “old.diglib.org” domain, with older DLF website files, can also be 

restored this way. Be very careful using either of these restore option since you will loose any 

changes you have made since the backup was created. It is also possible (though unlikely) that the 

backup was made at a moment when things were a bit out of sync on the WordPress site itself 

and you may have to clean up a few problems after the restore.

In addition to these automatic backups, we have also put some backup scripts in place that create 

a backup of the whole old.diglib.org and wp.diglib.org files along with the relevant databases into 

one neat package that you can download and store offsite for added security. This script runs 

every night and leaves a copy of the whole site at 
“http://diglib.dreamhosters.com/efc/get/” for you to 

pick up and put somewhere else. Beware, though, 

that this file is quite large, already about 1.4GB at 

the time of this writing. Anyone with Unix and 

WordPress experience should be able to recover 

the site from this copy, but it does take some 

expertise to know how to restore the site from this offsite backup.
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3.7. Troubleshooting

WordPress is a wonderful content management system and it generally runs without much 

incident. But things can still go wrong. Generally, when the site has problems the source of those 

problems will be outside of your control and you won’t be able to do much more than wait them 
out, but it is good to know at least who to call when situations arise.

While you have a support person available, certainly contact them. For now this is me, Eric 

Celeste, efc@clst.org, at 651-323-2009. But that may change so be sure you know who you can 

call. There are also issues that you can contact DreamHost about. The best place to start with 

DreamHost is their “Chat Live” service whose 

button is at the top of every control panel page. 

This service is a live interactive text chat and lets 

you describe your issue and get quick feedback 

about how it might be resolved. You can also 

copy and save the text transcripts for future reference. If text chat does not resolve the problem, 
there is a “Contact Support” item at the bottom of the control panel sidebar that will allow you to 

create a “trouble ticket” for the support staff at DreamHost. Tickets are also automatically tracked 

and saved for future reference in the control panel, you can even look at their history yourself, since 

there have already been a few!

In addition to contacting support when there is a problem, you can make sure you are getting 

notifications of issues that DreamHost 

distributes. The best way to do this is to 

subscribe to the newsfeed of alerts from 

DreamHost. Visit the “http://

www.dreamhoststatus.com/” page and 
take a look at the RSS feeds offered in 

the sidebar. Subscribe to those that you 

want to follow or just to the whole “Entries RSS” feed at the bottom of the page. An alternative 

would be to follow @dhstatus on Twitter, which essentially mirrors the same alerts.
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Some common issues and what you might do about them.

Issue Response

Server not found by 

browser.

Try loading another site, like Google. If that can’t be found, then 

the issue is bigger than our site. Try loading another site on our 
sever, like “http://old.diglib.org”. If that also can’t be found, then 

there may be a problem with DreamHost or Network Solutions. 

Usually the problem will be with DreamHost, so try a live chat 

session to alert them to the issue.

Only a message about 

database unavailable 
showing up.

In some cases the DreamHost database server will go down, even 

though the rest of DreamHost will be operating. If you see this 
message, try reloading the page, then try a live chat to alert DH.

Site is very slow. This could indicate problems at DH (try a live chat) or a growing 

load on our server. If it turns out to be the latter, we could consider 
implementing the WP Super Cache plugin, which would speed up 

the site considerably, though at the expense of some complexity 

in management.

Formatting of a story on 

the home page is 
messed up.

This probably indicates that someone went beyond bold, italics, 

and bullet points in their formatting of a story. Try editing the story 
and simplifying the formatting.
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4. Appendices

These are some details that didn’t have to clutter the main document. Note that some, in particular 

Appendix 4.4. should not be share outside CLIR staff! 
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4.1. Terminology

Admin Bar : a sleek grey bar at the top of the screen that appears only when a user logs into the 

site, first introduced with WordPress 3.1. It includes links for adding and editing content.

Content : means many things, but most often the core text of a page or post, highlighted on the 

DLF site with a yellow bar to the left.

Custom field : when editing a page in the WordPress backend you can assign custom field values 

in the box just below the text editing box. These fields are mostly created by the theme 

designer to facilitate special features in the theme. The DigLib theme can use custom fields 

like IncludeInMenu, SidebarNote, SidebarBox, RelatedLinks, and ShortName.

Footer : found at the bottom right of each page. Contains CLIR logo, last modified statement, 

rights statement, and link to privacy statement.

Identifier : WordPress uses identifiers internally a lot. An identifier in WP is simply a number. Each 

user has an identifier, each post has an identifier, each comment has an identifier, each 

page has an identifier. These identifiers can be hard to find, so we’ve installed a plugin that 

puts the identifier next to the edit link on the Admin Bar. If you are logged in and the Admin 

Bar is visible, then the identifier for each page or post or category will also be shown there.

Meta menu : menu in the top right corner of the page, containing items about the site and the 

login link.

Main menu : the most obvious navigational element on DLF site pages. Contains links to main 

“sections” of the site.

Page title : two specific meanings, unfortunately. One is the big red headline at the top of the each 

page of the site which is set by editing the title of the page in the WP backend. The other is 

the title put in the HTML header which uses the same title unless there is a ShortName 

custom field available for the given page.

Root parent page : see “section top page”.

Section top page : a page at the top level of the WP page hierarchy that represents the top of a 

whole section of the site, like the “About” section or the “Forums” section. This is also 

called the “root parent” page in some of the theme code.

Sidebar : found along the left edge of DLF site pages, with the DLF logo at the top.
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Sidebar box : a beige box in the sidebar, usually containing links relating to the page being 

displayed to assist in navigation.

Sidebar notes : text in the sidebar that helps explain the whole site or the page currently being 
displayed. Shown with a gray bar to the right.

Submenu : a menu containing the “second level” pages of the current section that have been 

highlighted.
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4.2. The Diglib Theme

WordPress sites can look like anything. You can dress them up in HTML and CSS to your heart’s 

content. This HTML, CSS, and PHP code is wrapped up into something that WordPress calls a 

“theme.” The theme we developed for this site is called “diglib” and repurposed much of the work 
DLF had done to build the Drupal theme a few years back.

CLIR and DLF decided at the outset of this process to spend zero effort on redesigning the DLF 

site. A new design had been created by eCoreXperience (http://www.ecorexperience.com/) with 

DLF staff in 2008/2009. They designed a site to run in Drupal, but due to changes in early 2010, 

that site was never deployed. Though Drupal was too heavy a management burden for CLIR, the 

site design was solid and DLF decided to roll it out as a WordPress site instead. 

As a WordPress theme, the resulting diglib theme leaves a lot to be 

desired. The code is full of many elements that really exist more to 

manage Drupal’s complexity than for any inherent WP purpose. The 

CSS stylesheet is almost unchanged from the work done for Drupal. 
The navigation menus, in particular, rely on an odd set of custom fields 

in WordPress to mimic their generation in Drupal. One good project for 

someone down the road would be to adopt the current WordPress 

menu structure to display navigation.

Anyone comfortable with HTML, CSS, and PHP should be able to 

navigate the diglib theme. Any alternate WordPress theme will also be 

able to display the DLF site, though some special navigation features 

(like our Main Menu, Submenu, and Sidebar contents) would go 

missing until some customization had been done.

The site also does not render especially well to print or mobile devices. 
Some future attention should probably be paid to these aspects of the 

site.
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4.3. Associated Services

Our WordPress site uses a few external services to present itself to the world. None of these are 

absolutely essential, but they certainly make our work easier.

Though DreamHost logs hits and provides some site statistics (you can find them under “Site 
Statistics” in the “Status” section of the DreamHost Control Panel), but they are not terribly well 

collected or presented. We have also created a Google Analytics code for DLF and insert it on 

every page with the assistance of a WordPress plugin. 

Users have an opportunity to log in to the site and leave comments. Yet we really don’t want to 

spend time managing user accounts on the system. We have installed Janrain to enable users to 

just use their pre-existing Google, Facebook, or OpenID logins to access this site as well.

Spam comments are an ever-present issue for sites that accept community input. We use 

Akismet to help filter out spam comments.

Each of these services requires a signup of its own. We’ve tried to use the dlfadmin@gmail.com 

account to create each of these other accounts. Full information about the credentials required for 

each of these services can be found in Appendix 4.4.
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